
1 Remove the tape and packing material from the printer.

2 Open the cover. Then peel off the tape and remove the insert. Do not
touch or remove the white cable inside the printer.

3 Insert the paper support into the three slots on the back of the printer.
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EPSON Stylus® C44 Series
Star t Here

Attach the Cable5

Unpack

Turn over

1

Do not touch
or remove the
white cable

Remove
insert

Power On2
1 Find the power cord that came in the box and connect

one end to the printer.

2 Plug the other end into a grounded 
electrical outlet.

3 P ress down firmly on the power button
until the gre e n power light comes on.

Caution: Use only the printer’s
power button to turn the printer 

on or off.

Power button

Load Ink3
1 Open the printer cover. 

C a u t i o n: Don’t touch the sensor behind
the ink cartridge holders. 

2 Lift up the ink cartridge clamps.

3 Unpack the ink cartridges that
came with your printer and
remove the yellow tape only.

4 Insert both cartridges.

Caution: You must install both 
cartridges or the printer won’t work.

5 Press down on the cartridge clamps
until they click shut.

6 Press the maintenance
button. The green power light
flashes and you hear the printer
charge its ink.

7 Close the printer cover. When
the green power light stops
flashing, charging is done.

Caution: Never turn off the printer while the green power 
light is flashing.

Maintenance 
button

Load Paper4

1 Connect the square end of the USB cable to your printer’s USB port.

2 Connect the flat end of the cable to any available USB port on 
your computer.

6 Install the Software

3 O p t i o n a l l y, click Install Photo Software. Select the software you want
to install and follow the on-screen instructions.

Note: If you see a message about installing QuickTime®, click Yes
and follow the on-screen instructions. At the end of Film FactoryTM

installation, deselect the option to launch the program, if necessary.

4 When you re t u rn to the Options Menu, click Install Printer Manual t o
copy the ES C44 Manual icon to your desktop. (Then whenever you
want to view the manual, just double-click the icon.)

5 When you’re done, click E x i t to close the Options Menu.

6 When you see the EPSON Product Registration screen, register
your printer as instructed. Then remove your CD-ROM.

You’re ready to start printing! Follow the instructions below.

Printing from Windows
1 Open a letter-size document in a pro g r a m .

2 Click the File menu and select
P r i n t. You see a screen like this:

3 Click P ro p e r t i e s or P re f e re n c e s.
You see this scre e n :

4 Select the type of document you’re printing:

• D r a f t : For rough drafts on plain paper. Saves ink.

• Te x t : For text-only documents, like letters or re p o r t s .

• Text & Image: For documents that have both text and images,  
like newsletters.

• P h o t o : For photos or graphics, when you want good quality 
with faster printing.

• Photo RPM: For photos or graphics, when you need 
highest quality printing.

5 Load the right paper for your document.
If you loaded special paper, select the
c o r rect paper type in the Type list.

6 Click O K. Then click P r i n t.

7 After a moment, printing begins. You see this window showing
your print job pro g re s s .

For more information on printing, double-click the ES C44 Manual i c o n
on your desktop to view the printer manual.

Paper type

Type of
document

Click to cancel printing

Click to pause or
resume printing

Shows ink levels

Black Color

Follow the steps below to install the printer software on Windows® XP. To
install software on Windows 98, Me, or 2000, see the booklet that came 
with your printer, Installing Software for Microsoft® Windows 98, Windows
Me, and Windows 2000.

For instructions on installing your Macintosh ® software, see the back
of this sheet.

Windows XP
1 Tu rn on the computer. (Make sure your printer is still on.)

2 Wait for this screen to appear.
DON’T CLICK ANY BUTTONS ON
THE SCREEN.

Note: If you don’t see the Found
New Hardware screen, see
“Problems?” on the back of 
this sheet.

3 Put the EPSON CD-ROM in your CD-ROM
or DVD drive.

Wait while the files are copied to
your computer.

4 Click F i n i s h when you see 
this scre e n .

5 Install your optional software, as
described below.

Installing Optional Softwa re for Windows XP

1 After a moment, you see the license agre e m e n t .
Read the agreement and click A g re e.

2 You see this screen. Make sure you have paper in the printer, then click
Print a Test Page to check that your printer is set up corre c t l y.

Click here

Don’t touch the green part

continue

1 Set some paper behind the tab on the right edge guide.
D o n ’t force it in.

2 P ress in the locking 
tab on the left edge 
guide and slide it 
against the paper.

3 Pull out the output tray.

Note: If you’re using special 
EPSON paper, make sure you load 
the brighter, whiter side face up.
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Macintosh 
1 Make sure your printer is on, then turn on your Macintosh. When you

see your Macintosh icons, put the EPSON CD-ROM in your CD-ROM 
or DVD drive.

2 Select the EPSON CD-ROM icon on your desktop, if necessary. 
Then double-click E P S O NI n s t a l l e r in your CD-ROM window. 

3 Read the license agreement and click A g re e.

4 At the Main Menu, click I n s t a l l
Printer Driver.

5 Follow the on-screen instructions to install your printer software and
restart your Macintosh. (You may need to enter your administrator
p a s s w o rd . )

6 After your Macintosh restarts, register your printer with EPSON as
instructed (except with Mac® OS X).

7 To complete installation, follow the steps below for your Mac OS.

Mac OS 8.5.1 to 9.x

Open the Chooser in the Apple ® menu, then select these options: 

• C44 Series
• Your USB port
• Background printing (on or off)

Then close the Chooser and install your optional programs, as described in
the next column.

Mac OS X 10.1.x and above

Open the A p p l i c a t i o n s folder, then open the U t i l i t i e s folder and select 
Print Center.

If Stylus C44 a l ready appears in the printer list, close Print Center and install
your optional programs, as described in the next column.

If Stylus C44 d o e s n ’t appear, make sure your printer is connected and turn e d
on. Then click A d d or Add Printer, and select these options:

• EPSON USB at the top of the screen
• Stylus C44 below

Click A d d, then close Print Center and install your optional programs, as
described in the next column.

Note: You can also add a driver supplying the Minimize Margins feature;
see your on-screen printer manual for details.

Click here

Replacing Ink Cartridges 
Black cartridge:
T036120

Color cartridge:
T037020

Caution: To ensure good results, use genuine EPSON ink cartridges and
don’t refill them. Other products may cause damage to your printer not
covered by EPSON’s warranty.

Low ink The re d e r ror light flashes and a status screen appears
telling you which cartridge is low.

Empty cartridge T h e e r ror light stays lit and the empty cartridge is
indicated on the screen; you must replace it to continue printing.

1 Open the printer cover and press the maintenance button
for 6 seconds. The print head moves to the cartridge’s replacement
position. (If both cartridges need replacement, the print head moves
to the black cartridge position first.)

2 Lift the ink cartridge clamp and remove the cartridge.

3 Unpack the new ink cartridge and remove the
yellow tape only.

4 Insert the new cartridge.

5 P ress down on the 
cartridge clamp until it 
clicks shut.

6 P ress the maintenance button. (If the other cartridge needs
replacement, the print head moves into loading position. Repeat
steps 2 through 6.) Then close the printer cover.

7 Wait until ink charging is finished (the green power light stops 
flashing and the e r ror light goes out).

Don’t touch
the green
part

Don’t load paper 
above this mark

The red e r ro r
light is on (nothing
p r i n t s ) .

If paper is out, load more paper and press the
maintenance button to resume printing.

If paper is jammed, press the m a i n t e n a n c e
button to eject it.

If the paper doesn’t eject, turn off the printer,
open the cover, and pull the paper out fro m
the front. Then reload paper, turn the printer
on, and press the maintenance button.

Paper jams fre q u e n t l y. Use new, smooth, high-quality paper.

D o n ’t load paper above the arrow mark
inside the left edge guide. 

Place the paper against the right edge
behind the tabs. Slide the left edge guide
against it, but not too tightly.

For more solutions to problems, see your on-screen printer manual.

Make sure your printer is on and the USB cable
is securely connected to your printer’s USB port.

If you still don’t see the screen, pull the USB
cable out of the computer’s USB port and
reinsert it.

You don’t see the Found
New Hard w a re scre e n
when you install the
Windows printer software .

Getting Help
EPSON provides technical assistance 24 hours a day through the electro n i c
support services and automated telephone services listed below:

World Wide Web
From the Internet, you can reach EPSON Support at
h t t p : / / s u p p o r t . e p s o n . c o m. Here you can download drivers and other files,
look at product documentation and troubleshooting information, and receive
technical advice through e-mail.

Automated Telephone Services
A variety of automated help services are available 24 hours a day, 7 days a
week. To use these services, you must have a touch tone telephone and call
(800) 922-8911. Your EPSON SoundAdviceS M E x p ress Code is 7 0 4 4 0. Use
this code to quickly select the EPSON Stylus C44 Series in SoundAdvice.

Viewing Your Manual
To view your printer manual, just double-click the ES C44 Manual icon on 
your desktop.

If you did not install your manual, follow the steps below to install it:

Windows

1 Put the EPSON CD-ROM in your drive. You see the Options Menu.

2 Click Install Printer Manual. 

Macintosh  

1 Put the EPSON CD-ROM in your drive.

2 Select the EPSON CD-ROM icon on your desktop, if necessary. 
Then double-click EPSON I n s t a l l e r in your CD-ROM window. You see
the Main Menu.

3 Click Install Printer Manual. 

Buying Ink and Paper
Use genuine EPSON inks and paper to get the best results from your
EPSON printer! You can purchase ink cartridges, paper, and accessories
f rom your local retailer or from the EPSON StoreSM at (800) 873-7766,
or visit w w w. e p s o n s t o re . c o m (U.S. sales only). In Canada, please
call (800) 463-7766 for dealer re f e r r a l .

H e re are three EPSON papers designed to work with your printer:

P remium Bright White Paper delivers crisp black
text and vivid, colorful images. It’s perfect for
everyday printing.

Photo Quality Ink Jet Paper is a bright white paper
with a smooth matte finish. It’s perfect for newsletters,
p roposals, and pre s e n t a t i o n s .

Glossy Photo Paper is a heavier weight glossy paper
that delivers photo lab quality. It’s perfect for color
photo keepsakes.

EPSON and EPSON Stylus are re g i s t e red trademarks of SEIKO EPSON CORPORATION. SoundAdvice and
EPSON Store are service marks of Epson America, Inc.

General Notice: Other product names are for identification purposes only and may be trademarks 
of their respective owners. EPSON disclaims any and all rights in those marks. 
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Installing Optional Software for Macintosh

1 Select EPSON Installer in your EPSON CD-ROM window.

2 Click Install Photo Software. Select the software you want to install
and follow the on-screen instructions.

3 When you re t u rn to the Main Menu, click Install Printer Manual to copy
the ES C44 Manual icon to your desktop. (Then whenever you want to
view the manual, just double-click the icon.)

4 When you’re done, click E x i t to close the Main Menu. 

5 Mac OS X only: Register your printer with EPSON as instructed.

6 Remove the CD-ROM. 

7 Mac OS X only: Restart your Macintosh in OS 9, then repeat the steps
in the “Macintosh” section to install the Mac OS 9 printer driver and
optional software for your Macintosh Classic applications.

Yo u ’ re ready to start printing! For instructions, double-click the 
ES C44 Manual icon on your desktop to view the printer manual.

Click here
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